Note: If the following documents do not solve your problem or if you have
any questions, please do not hesitate to contact us

Contact: support@maono.com

MAONO official website: https://www.maono.com/

Facebook: https://www.facebook.com/maonoglobal

IG: https://www.instagram.com/maonoglobal/

Notice: Whether it is a computer or software, in the sound settings, set
Maonocaster E2 as the default device !

1. Windows basic settings

STEP 1: Go to "Windows setting”.

STEP 2: Select "System”.
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STEP 3: Select "Sound” and go to “Sound Control Panel”.

< Settings

@ Home

Find a setting 2
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I 9 Sound

D Notifications & actions
2 Focus assist
(!) Power & sleep
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Clipboard
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Sound

Output

‘Choose your output device
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Certain apps may be set up to use different sound devices than the one
selected here, Customize app volumes and devices in advanced sound
options.

Device properties

Master valume
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Manage sound devices
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Choose your input device
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Certain apps may be set up to use different sound devices than the one
selected here. Customize app volumes and devices in advanced sound
options.

Device properties

Test your microphonea

A Troubleshoot

Manage sound devices

Advanced sound options

Related Settings

Bluetooth and other devices

N

Microphone privacy settings

Ease of Access audio settings

Help from the web

Troubleshooting Audio problem with
Windows update KB5015878

Turning on spatial sound

Setting up a microphone

Fixing sound preblems

@ Gethelp

&  Give feedback

STEP 4: Set Maonocaster E2 as default recording device in "Recording” of

sound setting.

mMaono
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M Sound
Playback] Recording |Sounds Communications @

Select a recording device below to modify its settings:

J =z
Maono Fairy
Default Device

=5

Maonocaster E2

Read:’
Cenfigure Speech Recognition /
Disable

5et as Default Device

Set as Default Communication Device

+  Show Disabled Devices

Show Disconnected Devices

Properties

Configure | | Set Default i".

oK | | cancel Apply

STEP 5: Double click "Maonocaster E2" go to "Properties”, select “Levels” and

set it to 100.
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STEP 6: Set the Maonocaster E2 as default playback device in “Playback” of

sound setting.
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¥ Sound @ X
|Playback Recording Sounds  Communications

Select a playback device below to modify its settings:

e mE==
@ o 2- High Definition Audio Device
¥4 DCefault Device

2781
HD Audio Driver for Display Audio
Ready

a e

Maonocaster E2
2ady

Configure Speakers

Test

Dizable

Set as Default Device

Set as Default Communication Device

~  Show Disabled Devices

EDI-‘};'F"EHFE - ' Show Disconnected Devices

Properties
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2. Software Audio Settings

After Maonocaster E2 is set up on the PC, how to set it in common software?
(Take Adobe Audition, OBS, DISCORD, ZOOM, AUDACITY, Twitch as
examples.)

Notice: If you set the Maonocaster E2 as the default device in the software
settings, it is still useless, you need to set it again!

Adobe Audition:

STEP 1. Open Adobe Audition and navigate through the menu to

Edit >Preferences--> Audio Hardware

H Adobe Audition
File Multitrack Clip Effects Favorites View Window Help

Undo

Redo Cirl+

Repeat Last Command

Toals >

Enable Channels >
Set Current Clipboard >
Cut Crl+X

Copy Ctrl+C

Copy to New Alt+Shift+C

Paste

Paste to New

Mix Paste...

Delete

Ripple Delete >

Crop Ctrl+T

Select

Insert
Marker

Zero Crossings

Snapping

Batch Process

Extract Channels to Meno Files

Band Splitter...

Freque

ret Sample Rate...

it Gricinal Ciil+E

Keyboard Shorteuts... Alt+K

General... Ctrl+Shift+K

Preferences

Appearance..

Audio Channel Mapping...

Audio Hardware...

Auto Save...

Contral Surface...

Data...

Effects...
Markers & Metadata...
Media & Disk Cache...

Memory...
Multitrack...

Multitrack Clips...
Playback and Recording...

Spectral Displays...
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STEP 2: Please select the device as Maonocaster E2 for Default input and

Default output.

Preferences X

OBS:

STEPT: Select "Settings” in “File”.
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€ OBS 27.2.3 (64-bit, windows) - Profile: 55 - Scenes: £2E

File = Edit View Docks Profile Scene Collection Tools Help

Show Recordings

Remux Recordings

Settings
Show Settings Folder

Show Profile Folder
Always On Top

Exit

STEP 2: Select "Audio”.
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STEP 3: Select the device to be used in “Desktop Audio”.

S Settings X

General

Channels

Global Audio Devices
Desktop Audio

Desktop hudio 2

Advanced

Defaunlt
Di

STEP 4: If you are using OBS and there is no sound, then please right click on

the AUX (microphone) and select properties
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Lock Volume

Unhide All
Hide

Rename

Vertical Layout
Audio Mixer
Filters
Properties
Advanced Audic Properties

-) &

STEP 5: Use Maonocaster E2 as your default device
€ Properties for 'Aux’ x

snocaster E2)

Defanlts
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DISCORD:

STEP 1: Open the “Setting”.

biscord =
a Find or start a conversation \& Friends Online All Pending Blocked Add Friend -+ D e

\& Friends ADD FRIEND Active Now
BoRRSSE

y You can add a friend with their Discord Tag. It's cAsE-sEnSitIvE!
DIRECT MESSAGES 1
It's quiet for now...
e Enter a Username#0000

When a friend starts an activity - like playing a
game or hanging out on voice - we'll show it here!

Wumpus is waiting on friends. You don't have to, though!

N Archerting | g,
Q #3029 v 0 @

STEP 2: Select "Voice & Video”.

Nitro ]

Server Boost

Subscriptions Voice Settings @
Gift Inventory INPUT DEVICE OUTPUT DEVICE ESC
Billing Default v Default v

APP SETTINGS INPUT VOLUME OUTPUT VOLUME

Appearance

Accessibility MIC TEST

Voice & Video I Having mic issues? Start a test and say something fun—we'll play your voice back to you.

Text & Images

Notifications Need help with voice or video? Check out our troubleshooting guide.

Keybinds

Language INPUT MODE

Windows Settings
® Voice Activity

Streamer Mode

Advanced O Push to Talk

ACTIVITY SETTINGS
INPUT SENSITIVITY

ATy Frvacy Automatically determine input sensitivity (/)
Registered Games

Game Overlay If the indicator is solid green then Discerd is transmitting your beautiful voice.

STEP 3: Select "Maonocaster E2" in “INPUT DEVICE & OUTPUT DEVICE".
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Nitro B

Server Boost

Subscriptions Voice Settings

Gift Inventory INPUT DEVICE Audiointerface  oursuroevice

Billing ==X, (Maonocaster E2) v #5575 (Maonocaster E2) v
APP SETTINGS INPUT VOLUME OUTPUT VOLUME
Appearance . | N
Accessibility MIC TEST

Voice & Video Having mic issues? Start a test and say something fun—we'll play your veice back to you.
Text & Images

MNotifications Need help with voice or video? Check out our troublesheoting guide.

Keybinds

Language

INPUT MODE

Windows Settings
@ Voice Activity

Streamer Mode

Advanced O Push ta Talk
STEP 4: Test whether the sound input and output are normal, if there is no
sound, please reconnect to the audio interface.

STEP 5: Turn off Automatic Gain Control.

Discord = O
Discord Nitro ® Hardware acceleration uses your GPU tor etticient video encoding and decoding, it available.
Server Boost
Subscriptions VOICE PROCESSING @
Gift Inventory Echo Cancellation [ @) £
Billing
Noise Reduction
APP SETTINGS
Appearance
Accessibility
Advanced Voice Activity (4)
Voice & Video

Turning this off may help if your voice is not being detected by the automatic input sensitivity.
Text & Images

Notifications Automatic Gain Control -
[Ptz | =

Keybinds
Turn off

Language
QUALITY OF SERVICE

Windows Settings
& Enable Quality of Service High Packet Priority a

Streamer Mode
Hints te your router that the packets Discord is transmitting are high priority. Some routers or internet service

Advanced providers may misbehave when this is set.

ACTIVITY SETTINGS
Activity Status ATTENUATION

Game Overlay

Lower the volume of other applications by this percent when someone is speaking. Set to 0% to completely
Chnanal an disahle attenuation

Z0O0M

STEP 1. Open Settings.
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& Zoom

— o e
< 5 @ QSemch  CtisF [, =) ®© w0
Home Chat Meetings Contacts Apps

1
Thursday, Marcl
New Meeting ~ Join
MNo upcoming meetings today
Schedule Share Screen
STEP 2: Click Audio.
) Settings x
General
Speaker
Video Test Speaker
= Qutput Level:
{ " fadio Volume: L] B o)
R
Share Screen (] Use separate audio device to play ringtone simultaneously
Chat Microphone
Test Mic
Zoom Apps
Input Level:
Background & Effects Volume: | o— )

Suppress background noise Learn maore
Profile O auto

St _J) Low (faint background noises)

(O Medium (computer fan, pen taps)

Keyboard Shortcuts (O High ttyping, dog barks)

Music and Professional Audio

o
Qo
@ Recarding (] automatically adjust microphone volume
e
L

Accessibility
(] show in-meeting option to enable "Original Sound” @

Ringtones  Default “| @
e QO Pt o N e e ol ol i | I R BT e Sl KA
| mdvanced |

STEP 3: Select the ‘Maonocaster E2'
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) Settings x

/ Audio interface
General
Speaker

reded [ TestSpeaker | Same as System (FHFORE (Maonocaster E2)) v

Cutput Level:
m Volume: q @
G Share Screen

(") Use separate audio device to play ringtone simultaneously

Audio interface

O Chat Microphone

| Test Mic | [ Same as System (Z5a/Rl (Maonocaster E2)) - J
@ Zoom Apps '

Input Level;
gﬂ Background & Effects Volume: q @ W
Recording (") Automatically adjust microphone volume

Suppress background noise Learn more

8 Profile O uto
i :
m Statistics — Low (faint background noises)
() Medium (computer fan, pen taps)
a Keyboard Shortcuts (O High (typing, dog barks)
Music and Professional Audio

Accessibility =
[_] Show in-meeting option to enable "Original Sound” (3

Ringtones

[ Advanced |

STEP 4: "Use separate audio device to play ringtone simultaneously” (uncheck
it)

and "Automatically adjust microphone volume” (Uncheck it)
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Settings
Q g

General

Speaker
Videa Test Speaker
= Qutput Level:
G Share Screen ’@ Use separate audio device to play ringtone simultaneously
O Chat Mo other audio devices are detected, please check your device connection again,
@ Zoom Apps Microphone
Test Mic

Q Background & Effects

Input Level:
Recording volume: 4 o— 1}
B Profile a Automatically adjust microphone volume

Suppress background noise Learn more
@ Statistics O auto

(:) Low {faint background noises)
Keyboard Shortcuts . .
() Medium (computer fan, pen taps)

ﬂ Accessibility () High typing, dog barks)
Music and Professional Audio

(] Show in-meeting option to enable "Original Sound” @

Dinrtrnac | Nafaok o o

| advanced |

STEP 5: Volume adjusted to 100%.
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) Settings x

General
Speaker
Videa Test Speaker
Qutput Level:
Volume: L] @ <)

[%5]
=
w
=
m
L
(=]
=
[ic]
1]
=

(] Use separate audio device to play ringtone simultaneously

Chat Microphone 100%
Test Mic
Zoom Apps
Input Level:
Background & Effects Volume: | @<
Recording (] automatically adjust microphone volume

Suppress background noise Learn maore
Profile O auto

() Low (faint background noises)

POO0O0OM®O

Statistics 2t

() Medium (computer fan, pen taps)
Keyboard Shortcuts (O High ttyping, dog barks)
Accessibility Music and Professional Audio

(] show in-meeting option to enable "Original Sound” @

Ringtones  Default “| @
e QO Pt o N e e ol ol i | I R BT e Sl KA
| advanced |

AUDACITY:

Set up Audacity audio inputs and outputs.

aAudacity
File Edit Select View Transport Tracks Generate Effect Analyze Tools Help

II b . I‘ '] . ’Tﬁﬂ ﬂ,; —5‘4 —&E- - Clieck Itu St:a_i't Hnniltoring IB *1‘2 —If‘ 0“
Qe KO ] N~ aalQQ&] »|e-
. MME b4 Z5M, (Macnocaster E2) V! 2 (Stereo) Recording Chann ~ ! ‘D iﬁ-?—FEE {Maonocaster E2) Vi

V| 1.0 0.0 1.0 2.0 3.0 4.0 5.0 6.0 7.0 8.0

L]
Cel

Click to the change the Audio input
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TWITCH STUDIO:
STEP 1: Open Twitch and navigate through the top left menu to

File-->Settings

Twitch Studio Beta - v0.110.14

File » Settings Ctrl+Comma

Edit b
View L
Window »
Help 4

@ Software & Manual Download | MAONO - ...

i

Change Capture &

STEP 2: Select the Audio tab
Set Primary Microphone to Maonocaster E2
If you think the sound is not loud enough, you can use the microphone sound

enhancement

Genaral Advanced Audio Mixer
The Advanced Audio Mixer allows you to add and adjust app-specific
audio sources in your Audio Mixer. Apps will only be listed as audio
sources if they are outputting sound on your system.

Stream Quality

Stream Settings

Recording Primary Microphone

Aty (Default Mic) Z5/4 (Maonocaster E2)

Hotkeys
Transitions Volume

In-Game Overlay
Just Right
Import Scenes

Convert to Mon
Thi Iy 1
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Notice:
1. Whether it is a computer or software, in the sound settings, set the

Maonocaster E2 as the default device!

2. If you set the Maonocaster E2 as the default device in the software settings,

it is still useless, you need to set it again!

3. Turn off the automatic gain switch in the software, Automatically adjust the

microphone volume and more functions that affect the sound settings!
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